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eta/DYNAFORM TRAINING MANUAL

This training manual was created to familiarize new users with eta/DYNAFORM Version
3.0. The exercises in this training manual include pre-processing line/surface data,
creating a finite element model, defining parts as tools, setting forming parameters (blank
material and property, punch velocity, binder force, etc.), regulating the values of
adaptive mesh, and seamless and multi-stage sheet metal forming processes.

It also includes creating an LS-DYNA input deck file and post-processing the results of
LS-DYNA including blank trimming and springback. In advanced training, a more
complex drawing case is introduced that examines defining draw beads and adaptive
mesh. Multi-stage sheet metal forming processes also are dealt with in this case.
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eta/DYNAFORM 3.0 MENU SYSTEM

eta/DYNAFORM 3.0 is a pre- and post-processor which utilizes the MOTIF Graphic
User Interface. The main window of the user interface consists of six parts: the Menu
Bar, Display Area, Prompt Window, Dialog Window Display, Display Options and Icon
Bar.

          Menu Bar                  Icon Bar

  Dialog Window Display       Display Area            Prompt Window               Display Options

MENU BAR

The top of the eta/DYNAFORM 3.0 interface is composed of a series of menus
referred to as the “Menu Bar”. The menu system is setup as a tree structure; choosing an
option on the menu bar opens a menu that branches out into sub-menus or pop-up dialog
boxes. Brief descriptions for these menus follow:
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File 1. Open, create and save an eta/DYNAFORM database file.
2. Import and export data to and from eta/DYNAFORM.
3. Print setup and print.

Parts The parts menu is used to edit, manipulate and define parts. By default,
every entity created or read into DYNAFORM is assigned to a part.

Tools 1.   Define parts as tool/blank.
2.   Create and assign blank materials and properties.
3.  Generate and assign material stress-strain relationships, tool travel

velocity, and binder force.
4. Calculate the minimum distance between tool pieces, and auto

position tool pieces and blanks.
5. Animate tool motion; define draw bead geometry and force load

curves.

Preprocess 1. Generate and modify Point/Line/Surface data.
2. Create, copy, transform and manipulate Nodes/Elements.
3. Check element criteria (boundary, overlap, warpage, aspect ratio,

etc.).
4. Create boundary condition.

Analysis Set LS-DYNA control parameters, write out an LS-DYNA input deck
file, and run analysis directly from eta/DYNAFORM window.

Postprocess View analysis results and draw Forming Limit Diagrams.

Setup Set up the concerned parameters in building a finite element model.

Utilities Commonly used utilities are grouped in this menu.

View Manipulate the position and perspective of the model display.

DISPLAY AREA
     Models and graphs are displayed in this window.

PROMPT WINDOW
    Displays messages and prompts to the user.

DIALOG WINDOW DISPLAY
Commonly used dialog boxes such as Create Part are displayed in this area for user

convenience.
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DISPLAY OPTIONS
   Displays the current part and model display properties.

ICON BAR

      Open       Print                  Top          Rear         Virtual X    Virtual Z  Screen X  Screen Z        Zoom          Fill           Redraw
                                                    View        View          Rotation     Rotation   Rotation   Rotation

New    Save              Part               Side        Isometric     Virtual Y     Free       Screen Y          Pan           Trim           Clear
                     On/Off            View        View           Rotation   Rotation   Rotation                          Window

Refer to the User's Manual for additional information on each icon and its function.
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Opening/Creating an eta/DYNAFORM Database File

Getting Started
Type ‘dynaform’ (or an alias if one exists) in the UNIX window to activate the
eta/DYNAFORM program.
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Creating an eta/DYNAFORM Database File

Command:  File/New

1.  Select New from the File menu and eta/DYNAFORM displays the New File dialog
box.

2.  Select Inverted Draw from the Draw Type pull-down menu.

3.  Select MM, TON, SEC, N option in the Unit Type pull-down menu.

4.  Choose the directory in which you want the eta/DYNAFORM database file to be
created. Type the database file name in the type box. For this exercise, type
‘dftrain.df .’ The recommended practice is to add the extension .df (for dynaform) to

newly created files.

5.  Click OK  to exit. The eta/DYNAFORM database file is created and the file name is
displayed in the top of the prompt window.

Note: Refer to the Application Manual for a description of draw type.
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Reading Geometry Data

Command:  File/Import

1.  From the File menu, select Import and the Import Files dialog box is displayed.

2.  Select the Format pull-down menu and choose between the two types of geometry
data file: IGES and line data. For this exercise, select Line Data. All files with the
suffix .lin will be listed in the Files box.

3.  From the file list, select BINDER.LIN and click OK . The geometry will be displayed
in the X-Z plane view.

4.  Repeat the above steps and read in the file BLANK.LIN.

Note: DYNAFORM/FEMB files are line data files created (written) by either
eta/DYNAFORM or eta/FEMB. IGES files will have the suffix .igs.
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Save/Save As

When you finish a session with eta/DYNAFORM, save your model to the

eta/DYNAFORM database file before you close it. You should also save periodically
while you work so that you do not lose your work in the event of a power interruption or
hardware problem.

There are two commands that you can use to save a database file: File/Save and

File/Save As.

1.  Use Save to save changes to an existing database file. The save command saves your
file under the same name with which it was last saved and replaces the previous
version.

2.  Use Save As to create a new file under a new name.
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View Manipulation

At the top of the Display Window, the center of the Icon Bar contains several
functions for manipulating the model’s orientation. The user may manipulate the view by
clicking on any of these options: Top, Side, Rear, Isometric, Free Rotation, Axis
Rotation, Zoom, Pan, Fill, Trim Window or Active Window. The user can also open the
View menu to get a list of other functions related to model display.

1.  Select Isometric. This places the displayed geometry in an isometric view.

2.  Rotate the geometry dynamically about the Z-axis approximately 90° by using the Z-
Axis function of View/Rotation sub-menu.

3.  Select Fill from the icon bar. This makes the displayed geometry fill the screen.
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Editing Parts in the Database

All geometry in eta/DYNAFORM is based on parts. Every entity, by default, will be
created or read into a part. The parts menu is used to edit, manipulate, and define parts.

Command:  Parts/Edit

1.  From the Parts menu, choose the Edit  button. The Part Edit  dialog box is displayed
with the two parts that are defined in the database.

     The parts are listed by part name and property identification number. If the part name
is displayed in color, it signifies that the part is currently on. Otherwise, the part name
will be displayed in white signifying it is off. The user can modify the name, ID number

and color of the parts, create a new part or delete parts.

2.  Select Color.  This displays the Select Color dialog box.  Select the color yellow to
change the color of BINDER.S from red to yellow and select Modify . Change the
color back to red by repeating the step.

3.  Choose Close to exit.
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Current Part

All lines, surfaces and elements created will automatically be included in the current
part. The current part name is displayed in the Display Options window at the lower right
of the graphics screen in its part color.  Prior to creating any new lines, surfaces and
elements, make sure the desired part is current.

When automeshing surfaces, the user may assign the intended elements to each

individual part containing surfaces; thus, having the desired target part current is not
necessary.

Command:  Part/Current

1.  Select Current  from the Part Menu and the Part Current  dialog box will display.

2.  The default function is Select by Cursor at Line. Click on one of the lines of the

BLANK (green part) with the left mouse button. The part BLANK.LI will become
the current part. The user can also use Select by Name to perform the same
command.

3.  Select Close to exit.
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Turning Parts On/Off

Command:  Parts/Turn On

1.  From the Parts menu, select Turn On  and the Part Turn On/Off  dialog box will be
displayed.

2.  Select Cursor at Surface and click on BINDER.S (red part). This part will be turned
off. The user can do the same thing with Select by Name.

3.  Select OK and proceed with the next command.

4.  Select Fill  from the Icon Bar.
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Modeling From Line Data

Command:  Preprocess /Element /4 Line Mesh

1.  After selecting the 4 Line Mesh icon, the Control Keys dialog box displays. Choose

Select Lines and pick four lines of the BLANK sequentially in a clockwise or
counter-clockwise order, starting from one of the straight edges.

2.  Enter a reasonably fine mesh density of  ‘75’ for N1 and ‘100’ for N2 from the No. of
Elements dialog box and click OK.

Note: N1, N2, N3, N4 are the number of elements to be created along each of the 4
sides. If the mesh is uniform, only N1 and N2 need to be defined.

3.  The generated elements are displayed in white.  eta/DYNAFORM prompts:
> ACCEPT MESH?
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4.  Click Yes with the left mouse button to accept the mesh. This enables the user to see
the results of the mesh.

5.  Select Exit  to exit the 4 Line Mesh function.

6.  Select Save to save the recent changes.
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Auto-Meshing Surface Data

1.  Turn the BLANK off and the BINDER on by Parts/Turn on.

2.  Select Preprocess/Elements/Surface Mesh and the Surface Mesh dialog box will be
displayed.

3.  In the Mesh Type box, select Connected.

4.  Select Select Surfaces and the Select Surface dialog box will be displayed. The user
can select the surfaces by part, by window or by mouse pick. In this exercise, select
Displayed Surf and click OK .

5.  In the Surface Mesh dialog box, enter ‘16’ to set the Maximum element size.
Accept the default values for the Minimum element size, Chordal deviation and
Angle. Chordal deviation controls the number of elements and Angle controls the
feature line.
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6.  Toggle In Original Part on.  eta/DYNAFORM creates and stores the elements in the
part from which they were created. If In Original Part is off, eta/DYNAFORM
creates and stores the elements in the current part.

7.  Select Apply  to create and optimize the mesh.  The generated elements are displayed
in white.  eta/DYNAFORM prompts:
>  ACCEPT MESH?

8.  Select Yes to accept the mesh.

9.  Select OK to exit Surface Mesh function.

10.  Toggle Display Surface off in the Setup menu to turn off the surface display.

11.  Toggle the surfaces back on and then turn the BINDER off under Parts/Part on.

12.  Select Save to save the change.



eta/DYNAFORM Training Manual

eta/DYNAFORM 3.0 17

Tool Definition

      The Binder and Blank are now modeled. The next step is to read in the Die surfaces,
auto-mesh, and then create the Punch.  This is done by copying the Die elements and
offsetting them by the thickness of the Blank. The parts will then be assigned to a
respective Tool and most of the analysis parameters will be defined. This is done using
the functions in the Tools menu.
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Auto-Meshing the Die Surface Data

1. Read in the file DIE.LIN under File/Import  ...

2. Repeat Step 1-12 in Auto-Meshing Surface Data to auto-mesh the die surface. Set
the maximum element size to ‘16’, the minimum element size to ‘1’ and the chordal
deviation ratio to ‘0.05’.
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3. Next, select Preprocess/Model Check/Auto Plate Normal.

4. Select All Active Parts in Control Keys dialog box and click Done.

5. Pick an element of the Die with the left mouse button.
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6. An arrow displaying the normal direction of the element selected will be shown. This
arrow should be pointing in the -Z direction. If not, select No when asked if the
direction is acceptable. The element normal will be checked and re-oriented in the -Z
direction.

7. Select Save to save the change.
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Offsetting the Die Mesh to Create the Punch

After the Die elements have been normalized, the next step is to create the Punch by
copying the elements of the Die and offsetting them in their normal direction by the

thickness of the Blank.

Command:  Parts/Create

1. Select Parts/Create to create a new part called “Punch."

2. Select Preprocess/Elements/Copy.

3. In the Copy Elements dialog box, select Offset in the Type pull-down menu.
Toggle In Original Part  off and select copy number 1. Once that is done, enter an

offset thickness = blank thickness + 10 % × thickness.

4. Select Select Element to choose the elements. Since we only want to copy the

elements that make up the U-channel of the die (not the flat surface), select the Side
View option from the Icon Bar.

5. Select Drag Window from the Select Elements dialog box. Drag a window as
shown below and select OK :
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6. Select Apply and click OK .

7. Select Save to save the current changes.

Note: By turning the Die off, you could be left with only the “Punch” model
displayed.
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8. Select Isometric in the Display Options. The punch will be displayed as the
following:
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Defining the Parts As Tools

Command:  Tools/Define Tools

1. Select Tools/Define Tool and select Die in the Tool Name pull-down menu. Add the
part called “Die.s” to be defined as the Die by using Add.  The “Die.s” and PID will
be displayed in the Include Parts List field.

2. Repeat the above steps for the Punch and define "BINDER.S" as the Lower Ring.

3. Select Save to save the changes.
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Define Blank Material/Property

Command: Tools/Material and Tools/Property

1. From the Tools menu, select Material to display the Material  dialog box.

2. In this box, type ‘Blnkmat ’ for the name of the material (or any other name you like).
Select Type 36 and click New. The Material menu for this type will be displayed.

The user can change property values by clicking on the value with the left mouse
button, entering the new value and then hitting return.

3. Edit MATERIAL PARAM (N)  to be 0.23 and click Ok. The name of the defined
material will appear in the Material  field.

4. Next, select Blank Property from the Tools menu to display the Property dialog
box.

5. In this box, type ‘Blnkprp ’ in the Name field.
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6. Select BELYTSCHKO-TSAY  shell element, select New and edit the Uniform
Thickness field in the dialog box to be 1.0mm.

7. Click OK  in the Property dialog box, the name of the defined property will appear in
the Property field in the Define Blank dialog box.  

8. Select Tools/Define Blank menu.  Assign the material and property to “Blank”.

9. Turn all parts on by Parts/Turn on/All on .

10. Select Save to save the changes.
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Auto Positioning Tools

Command: Tools/Position Tool/Auto Position

1. eta/DYNAFORM will now adjust the spacing between Tools and Blank based on the
default Blank thickness (i.e. 1.0mm).

2. Check the spacing between the tools by selecting Auto Position/Min. Distance.

3. In Min. Distance between Tools dialog box, select BLANK  for the First Tool  and

PUNCH for the Second Tool. Select OK  and 1.000 appears in the Distance field.  In
the prompt window, MIN. DIST. BETWEEN BLANK-PUNCH IN Z=-1.000E+01
displays.

4. Repeat the above step, this time select PUNCH as the First Tool , and DIE as the
Second Tool. This distance should be 42.01mm. The distance measured is the total
draw depth and will be used in the next section to generate the punch velocity curve.
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Define Contact  Parameters and Punch Velocity Curve

Command: Tools/Define Tools /Define Contact.

1. Select Die in the Tool Name pull-down menu for defining the Die contact.

2. Select contact type Forming-One-Way-S-S.

3. Edit the Static Friction value to be 0.11 in the parameter dialog box and select OK .

4. Repeat the steps for the Punch and the Lower Ring by selecting their respective
name in the Tool Name list.

5. Select Punch in the Tool Name pull-down menu, then select Define Motion/Auto
Create Curve and click Done.
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6. In the Velocity/Time Curve dialog box, type ‘1000’mm/s for velocity, and
‘41.01’mm for stroke distance. The stroke distance = the distance measured
previously between the Punch and the Die ’42.01’mm -the Blank thickness
1.0mm=41.01mm.

7. Select Full Screen to display the punch velocity curve as shown below.

8. Select Done and then Exit .
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Defining Lower Ring (Binder) Force Curve

1. From Tools/Define Tools, select Lower Ring in the Tool Name pull-down menu.

2. Select Define Force/Auto Create Curve and click Done.

3. Type ‘200000’ N in the force field and click Ok.

4. Select Full Screen to display the Binder Force Load Curve as the following.
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Preview Tool Animation

Command: Tools/Animate

      Before running the analysis, the user should preview the tools’ animation. Select

Tools/Animate to see the results.
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Run Analysis

1.  Open the dialog box Analysis from the Analysis menu.

2.  Select DYNA940 Input File for Analysis Type.

Note: The user has the option of two analysis types: Dyna950 Input File and

Dyna940 Input File. There is a slight difference between the Dyna950 Input
File and the Dyna940 Input File dialog boxes. The user can compare their
contents with the following two figures. If the user selects Dyna940 Input
File, the user will toggle the button Springback to get a NIKIN file after
running. If the user selects Dyna950 Input File, the user will toggle the

Seamless button in the Analysis menu. The Seamless function can directly
handle trimming and springback when running. For more detailed information,
please refer to the User's Manual.
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3.  Check the Control Parameter menu to make sure all of the parameter values are
acceptable.

4.  If Adaptive Mesh is needed, the user can open the associated dialogue box and check
the values of the parameters. In this case, the user need not use it.

5.  Type ‘dftrain ’ in the File field and ‘DYNAFORM training exercise’ in the Title
field.

6.  The input files will then be written and the user can submit them to LS-DYNA.

Note: Two files are written out, dftrain.dyn and dftrain.mod. Dftrain.mod contains all of the model
data which is referenced by an ‘include’ statement in the dftrain.dyn file.

Note: Once the job is submitted, type ‘ctrl-z’ in the window where the job is running. Then type ‘bg’

once the Unix prompt appears. This will put both Dyna and Dynaform in the background. Then,
to update the job runtime, simply type ‘kill -2 ps’, where ps=dyna process #. If a Sense Switch

other than SW2 is desired, create a text file called ‘switch’ with that particular switch listed (i.e.

sw1, sw3 etc.). This switch file should be located in the directory where you enter the ‘kill -2’
command. Now, instead of the default sw2 switch being used, the command saved in the switch

file will be used.
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Note: The analysis can also be submitted from the Unix command line by typing ‘dyna i=input

filename.' Dyna is the alias to run LS/DYNA and the input filename would be dftrain.dyn in this
case. If more memory is required, the command ‘dyna i=input filename memory=# of words

short’ can be used to submit the job and reallocate the required memory, where ‘# of words
short’ is the additional memory required in bytes.

Once the job has finished running, we will post-process the results in
eta/DYNAFORM and trim the Blank before running the Spring Back analysis. We will
then post-process those results in eta/DYNAFORM.
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Post Processing Forming Results

eta/DYNAFORM can read and process all the available data in the D3PLOT file.
In addition to the undeformed model data, the D3PLOT file also contains all requested
result data (stress, strain, time history data, deformation, etc.) from LS-DYNA.
eta/DYNAFORM will automatically create a new database called ‘d3plot.df’ into which
we will read in the D3PLOT file directly.
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Post Processing – Reading a D3plot File

1.  Select Open in the File menu and the Open File dialog box is displayed.

2.  Toggle Postprocess File on and choose d3plot.

3.  Select d3plot in the File field and click OK .

4.  Select LS940 from the SELECT DYNA3D VERSION  dialog box.
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5.  In the dialog box, Select Step, select the step you need. For this exercise, toggle the
button All .

6.  Select All Components. All of the D3PLOT files will be read into eta/DYNAFORM.

7.  Keep only the Blank on by using Parts/Turn on.

8.  Select Isometric View from the Icon Bar.
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Post Processing-Animating a Contour

1.  Select Postprocess/Animate Contour and the Animate Contour dialog box is
displayed.

2.  Select Others from the Components pull-down menu and then select the Thickness
component.
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3.  Select Display Option, set the Contour Color Type to Continue in the Display
Option pull-down menu and select OK .

4.  Toggle Shade at the right hand corner of the screen in the Display Options.
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5.  Select Play. eta/DYNAFORM will construct and animate the thickness contour plots
for all 10 times steps. The contour plot for the 10th time step is shown below.

6. The user can see the individual frame by toggling Individual Frame  on and to
discontinue the animation, select Stop from the Animate dialog box.

7. Select Close in the Animate Contour dialog box.
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Post Processing-Plotting a Contour/Listing a Contour Value

Command: Postprocess/Plot Contour

1.  Select Postprocess/Plot Contour.

2.  Select Step #10 with the Current Frame  slider, select Others from the Components
pull-down menu and select the Thickness component.

3.  Click Plot. A contour plot is displayed similar to the one on the previous page.

4.  Select List Contour Value.

5.  The default setting is Select By Node. Pick a node on the model by clicking the left
mouse button.
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6.  A table appears in the lower left region of the display area indicating the thickness
value for that node.

INDEX NODE ID THICKNESS
1 6162 0.9400

7.  Select Profile. This option displays the contour value for all the nodes in the model
and lists them in a table. The table size is limited to 10 values. Scan through the table
by using the Browse Value commands to go to the previous and next table listings
respectively.
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Post Processing - Plotting a Contour with a Forming Limit Diagram

This feature displays a contour plot based on a Forming Limit Diagram that is read in,
or defined by the user. The Forming Limit Diagram is based on material properties N, R,
and T (where N = Resistance to Necking, R = Anisotropic Hardening Parameter, and T =
Thickness).

1.  Select Postprocess/Plot FLD.

2.  Select Engineering in Strain Type.

3.  Select Defined by n, r, t in FLD Curve and set the r value to e 1.04.  Accept the
default values n=0.23 and t=1.0.

4.  Select the Middle surface in the Layer pull-down menu.

5.  Choose the 10th time step in the Current Frame .



eta/DYNAFORM Training Manual

eta/DYNAFORM 3.044

6.  Select Plot.                                 
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7.  The FLD will be displayed in the left upper corner.



eta/DYNAFORM Training Manual

eta/DYNAFORM 3.046

8.  Select List FLD Value  in the Plot FLD dialog box and select ALL . This will plot a
contour based on the FLD curve defined and will show all the elements locations on
the curve. This will also tabulate the 10 elements with the highest strain values along
with their formability status (i.e. Buckling/ Marginal/ Critical/ Fail), as shown below.

9. Select OK  in the List FLD Values dialog box.

10. Select Close in Plot FLD dialog box.

11. Exit Post Process.
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Trimming the Blank

eta/DYNAFORM has a trimming function that allows the user to trim the blank
before running a Spring Back analysis. For this exercise, we will read the NIKIN file into
eta/DYNAFORM, view the formed blank shape, trim the blank based on a given trim
line, submit the job to LS-NIKE, and then post-process the results.

1. Create a new database called ‘dftrain3.df’. Select Draw Type - Springback.

2. Command: File/Import
Select File/Import  and choose Nike3D Input in the Format pull-down menu.  Select
the file nikin.nik .  Repeat the above step to import trimline.lin file in the Line Data
format into eta/DYNAFORM. The user will get the following figure.
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3. Command: Tools/Blank Miscellanies/Trim
The dialog box will appear on the screen. Choose the trim line on the screen and select
OK .
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4. Another dialog box appears on the screen for the user to select the direction of the
trimming and eta/DYNAFORM prompts the user to select a node for the origin.
Select one node and toggle Define By 3 Location off in the LCS dialog box to enable
the U, V, and W Axis buttons.
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5. Select the W Axis from the LCS dialog box as the trimming direction and press OK .
The W Axis dialog box appears:

6. Select Along Axis from the W Axis dialog box and the following dialog box will
appear.  Select Along X and Done.

7.  The W Axis dialog appears.  Select OK .  Then, the LCS dialog box appears.  Press
OK  again.  The Tolerance dialog will then be displayed.  Accept the default value
in the Tolerance dialog box.

8.  A text window appears on the screen. eta/DYNAFORM prompts:
> EXCLUDE ELEMENTS FROM TRIM LINE?

Select Yes and see the result of the trimming.
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9.  Open Part/Turn On and turn off TRIMLINE and TRIMOUT. This enables the user
to see the trimming result in part MAT00002.

Since we will be running a linear, static analysis, some locations must be constrained
on the Trimmed Blank model to eliminate rigid body motion. We will do this by using
Single Point Constraint (SPC) to constrain the minimum 3 points. The constraint
sequence, shown in the following figure, is based on the global coordinate system.
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     Z

•Y SPC – Z direction

SPC – XYZ directions   •
               Node #1

    • X SPC – YZ direction
Node #2

10.  The user should select nodes on the surface of the blank to constrain the rigid motion.
Change the view to Top View.  Select Preprocess/Boundary Conditions and a
dialog box is displayed on the screen. Choose SPC OPTION, select Done and the
SPC Set dialog box displays.



eta/DYNAFORM Training Manual

eta/DYNAFORM 3.0 53

11.  The following is displayed:

Select Create to create three points on the center of the blank surface in terms of the
figure. These three points can be removed from the rigid body motion when the user
needs to perform the springback portion of the analysis.  Select three points as describe in

the SPC figure on the previous page. The position of the three points should be in the
center of the blank surface.

12.  Select OK  in the SPC Set dialog box and the Boundary Conditions dialog box
displays.

13.  Select Exit .
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Post Processing Springback Results

eta/DYNAFORM can also read and process all the available data in the N3PLOT
file.  The undeformed geometry is contained in this file along with the results.

1. Select File/Open.

2. Toggle Postprocess File on and then choose n3plot.

3. Select n3plot in the File field and click OK .

4. Repeat step 4 – 8 of Post Process - Reading d3plot File.

5. Select Postprocess/Animate Deformation to see the results of the springback
analysis.
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6. Select Postprocess / Plot Deformation.
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Conclusion

This concludes the training guide’s basic overview of eta/DYNAFORM.  The
user should now have the basic skills necessary to create models, prepare models for
analysis and display result data.  Please reference the User’s Manual for more detailed
explanations of each function.
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